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HOU provides a visual and analytic way of exploring the universe.

Use HOU images from professional telescopes, along with HOU image processing software, to pursue
investigations of astronomical objects, phenomena, and concepts. Opportunities available to HOU stu-
dents can lead to accessing professional-grade telescopes via the World-Wide Web for observations as
part of research projects such as searching for supernovae and asteroids.

• HOU has been developed and operated by staff at Lawrence Berkeley National Laboratory
and Space Science Laboratories at the University of California at Berkeley, Californa, with
generous support from the National Science Foundation (grant # ESI-9252915) and the US
Department of Energy.  The HOU curriculum was developed by TERC with contributions
from the Berkeley staff and teachers.  The educational center for HOU currently resides at
Lawrence Hall of Science, University of California, Berkeley.

• The Berkeley staff responsible for the development of the HOU system includes:
Carl Pennypacker, Elizabeth Arsem, Kinshuk Govil, John Refling, Gerard Monsen, Jeff
Friedman, Dick Treffers, Julia Lee, and Mimi Kwan (with past contributions from Silvia
Gabi, Bruce Grossan, Michael Richmond, and Rori Abernathy).

• The curriculum development team includes:
Tim Barclay and Jodi Asbell-Clarke from TERC
(with contributions from Hughes Pack, Northfield-Mount Hermon School; Phil Dauber,
Alameda High School; Rich Lohman, Albany High School; Tim Spuck, Oil City High School;
Vivian Hoette, Adler Planetarium; Alan Gould, Lawrence Hall of Science; Geri Monsen,
and Carl Pennypacker).

• Lawrence Hall of Science HOU staff includes:
Carl Pennypacker, Alan Gould, Miho Rahm Lulu Lin, and Amelia Marshall.

HOU High School Curriculum Materials are copyright © 1995-2000 by TERC.  All rights reserved.
HOU Project, Software and other HOU Educational materials are copyright © 1995-2000 by The
Regents of the University of California.  All rights reserved. Hands-On Universe™ is a trademark of
the Regents of the University of California.
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 HANDS-ON UNIVERSE™
Constants Sheet

Planetary Data:

Planet       Mass (kg)        Ave Radius (m    )      Ave Orbital Radius(m)

Mercury 3.32 x 1023 2.44 x 106 5.79  x 1010

Venus 4.87 x 1024 6.08 x 106 1.08  x 1011

Earth 5.97 x 1024 6.36 x 106 1.49  x 1011

  Moon 7.35 x 1022 1.74 x 106

Mars 6.42 x 1023 3.40 x 106 2.28  x 1011

Jupiter 1.90 x 1027 6.80 x 107 7.78  x 1011

Saturn 5.69 x 1026 5.70 x 107 1.43  x 1012

Uranus 8.69 x 1025 2.51 x 107 2.87  x 1012

Neptune 1.03 x 1026 2.44 x 106 4.50  x 1012

Pluto 1.30 x 1022 1.50 x 106 5.90  x 1012

Physical and Astronomical Constants:

Gravitational Constant = G = 6.673 x 10-11 N-m2/kg2

Speed of Light in a vacuum = c = 2.9979 x 108 m/s
Earth-Sun Distance = Astronomical Unit  = AU = 1.496 x 1011 m
Earth-Moon Distance = 3.844x 108 m
Parsec = pc = 206265 AU = 3.26 ly = 3.09 x 1016 m
Light year = ly = 9.5 x 1015 m
Mass of the Sun = 1.989 x 1030 kg
Luminosity of the Sun = 3.83 x 1026 W
Radius of the Sun = 6.96 x 108 m
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HANDS-ON UNIVERSE™

INTRODUCTION TO IMAGE PROCESSING

Activity I:  Displaying An Image

• Double click on the HOU icon in the HOU window.

Your initial image processor screen should show the following:

Note the row of icons on this Tool Bar.  If you place the cursor on one of the icons, its

name pops up.

1 .   Go to the answer sheet and write in the name for each of these icons.

To Open an Image

• Click on the open file folder icon or use the Open  command in the File menu.

Open the image called Moon.  For older versions of the software, you will need to

select 'All Files' from the list of file types to see the listing of all available fts and

.fth files.  From now on this instruction about opening images will be given in

'Screen Setup', as shown on the next page.
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Screen Setup: Moon

• In the View menu the options include four bars: Tool Bar,  Status Bar,  Color

Palette Bar, and Display Controls Bar.  Toggle these on and off to see what each

name refers to.

2 .  On the answer sheet, label each of these bars.

To Use Zoom On An Image

• The default value for Zoom on the Display Control Bar is “1”.  Change this to “2”

and click on Redraw or press the Enter or Return key on your keyboard.

• Try other values for Zoom.  When the image gets too large for the window, scroll bars

appear on the window.  Scroll to see all the parts of the image.

To Adjust the Image Contrast

Min/Max    .  This controls the shading (or the coloring).  Assuming the palette is Grey,

pixels dimmer than Min will be black and pixels brighter than Max white.  Everything in

between will be a shade of grey.

The software assigns shades of grey or colors across the range of brightness between the

Min and Max.  Changing the values to make the range narrower brings out more detail in

the parts of the image whose brightness is within that narrower range.
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Screen Setup: Two images of Moon side by side, labeled Moon.fts;1 and Moon.fts;2, both

with Zoom 2 or 3.  From View choose Color Palette Bar.

With the same image in two windows, you can change settings in one and see by

comparison what difference it makes.  The Display Controls Bar and Color Palette

Bar only refer to the active window, the one with its title bar highlighted.  The Status

Bar, however, gives the (x,y) coordinates of the cursor position and the Counts value of

brightness at that position for whichever image the cursor is on.

Min/Max values in the Display Controls Bar can be changed in four different ways:

Drag, Click, Press, or Enter.

Drag the tabs in the slide bar.

Click inside the slide bar to either side of the tabs.

Press on the arrows at the ends of the slide bar.

Enter new values in the boxes at either side.

• Change Max in one image to approximately one half as great.

3 . Describe what happens to detail in the bottom left part of the image.

4 . Describe what happens to detail in the top part of the image.

• Select Reset Default Min/Max in the View menu to reset to the original Min/Max

values.

• Double, triple, or even quadruple the Min value.

5 . Describe what happens to the detail in the bottom left part of the image.

6 . Describe what happens to the detail in the top part of the image.

• Select Reset Default Min/Max and click on Log.

7 . How does Log scaling alter the image?  What is better?  What is not?

Log Scaling brings out detail in dimmer parts of an image.  You may need to adjust

Min/Max to enhance the features you are interested in.  Did you note the better detail in

the lower part of the image?
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Activity II:  About the Display

Screen Setup:  Two images of Moon side by side, labeled Moon;1 and Moon;2, both with

Zoom 2.  Select Log for the Moon;2 image.  Display the Color Palette Bar.

Cursor       Information    :  The (x,y) coordinates and the brightness in Counts for the cursor's

position are displayed in the Status Bar at the bottom right of the screen.  Each (x,y) pair

of coordinates identifies a specific location, called a picture element or pixel for short.  

Display        Region    : The dimensions in pixels of the image displayed without scrolling.

8 . What are the (x,y) coordinates of the bottom left corner of the window in Moon;1?

9 . What are the (x,y) coordinates of the top right corner of the window in Moon;1?

10 . What are the window’s dimensions?

11,  12 & 13 . Increase the Zoom to 4 or 5 in Moon;1 and answer #8, 9 & 10  again.

14 . Compare Moon;1 with Moon;2 and describe the effect of Zoom on the displayed

window dimensions and upon the (x,y) coordinates of features in the image.

15.  Scroll Moon;1 and compare the dimensions of the image window, only part of which

is displayed at any one time, with the image window dimensions at Zoom 2.

Brightness   :  With Log Scaling in one image and normal linear scaling in the other, the two

images look very different.  It is the display of the image that is changed, not the image file

data.  To see this, choose a bright spot and a dark spot, such as the peak in the big crater

and the dark center of a small crater.  Go to the same place on each image.

16 . Record your pixel coordinates and brightness values for the bright and dark spots in

Moon;1 and Moon;2.

Color Palette Bar. This bar shows the range of shades or colors associated with the

palette in the active window.  The numbers beside the bar are brightness in Counts.

• For both images, select rain.pal by pressing on the current palette name in the selection

box on the Tool Bar or selecting Load Color Palette in the File menu.

17 . By looking at the Color Palette Bar, estimate the range of values for the lightest

shade of pink in Moon;1.

18 . By comparing Moon;1 and Moon;2 describe how log scaling changes the range of

Count values assigned to each color.
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Activity III:  Tools For Analyzing Images

Screen Setup:  One Zoom 2 or Zoom 3 image of moon with default Min/Max (use Reset

Default Min/Max).

A short description of any icon or highlighted option in the main menu is given at the

bottom of the screen.  Fuller descriptions are included in Help.  Click on the Help icon,

move the ? to the item and click again.

• Select Zoom Box in Data Tools.  The cursor becomes a square icon.  By dragging

with the mouse, draw a box around part of the image.

• Zoom Box three more times.  Use Cascade and Tile in Window to see what these

options do to the display.  If you do not see a window, select it in Window to bring it

to the front as the active window.

• Click on the icon or select Cleanup marks from View if boxes are cluttering the

image.  This erases marks, but not the image, in the active window.

Screen Setup:  One Zoom 2 or 3 image of moon.

• Use Slice in the Data Tools menu to get a brightness graph.  A slice is drawn by

dragging the cursor across a part of the image.  Start above the central peak inside the

crater, cross the central peak, and end beyond the crater ridge.

The Slice graph is a plot of brightness in Counts versus distance along the slice in pixels.

Make the Slice window larger by dragging the borders (PC) or the bottom right corner

button (Mac).  Arrange the Image and Slice windows so both are visible.

• Drag with the mouse on the Slice graph to see Distance and Count values displayed at the

cursor position.  The position along the slice is also shown in the image window.

Compare the values shown in the Status Bar with the values in the Slice window.

• Select Axes Setup from the Options menu, add Grid on both axes and change the Tick

spacing as appropriate.

19 .  On the answer sheet draw your slice line on the image and sketch the graph.  Label

bright and dim points on the graph and their corresponding spots on the image.

20.  Why are the cusps (high points) in the graph all different heights?

21 . What is the distance, in pixels, from the central peak to the large crater rim?



Intro to Image Processing - version 6/00     © 1995-2000 by TERC 8

Activity IV:  Explore A Solar Eclipse

Screen Setup:  Eclipse1.  This image was taken in Hawaii in 1991 by an HOU team.  If

you have trouble downloading the compressed file, .fth, download the uncompressed

version, .fts.

• Scroll down to the bottom rim of the sun.

• Try some color palettes such as Rain.pal and WRMB.pal.  Adjust the contrast  using

Min/Max so you can see the sun's rim.  See if Log scaling helps.

22 . Record your settings.

Analyzing the Prominence at the Bottom of the Sun’s Image

A solar prominence is a cloud- and flame-like structure in the corona and

chromosphere, the sun’s layers of atmosphere  They are only visible during a solar

eclipse when the light from the sun does not block them out, just as the stars are

blocked out in the daytime sky.  A prominence in profile outside the solar disk is a

bright feature that can extend thousands of kilometers from the solar disk and last for

many months.  The bright eruption at the bottom of the Eclipse1 image is an example of

a prominence. There are more bright spots visible in the image that are probably other

prominences beyond the sun’s edge.

• Select Zoom box from Data Tools and make a box around the prominence.

• In the Display Controls Bar, change Zoom to get as large a display of the prominence

as possible that still fits on the screen (no scroll bars added to the window).
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23 . Using the cursor and the Status Bar, measure the height in pixels of the solar

prominence above the sun's rim and the diameter of the sun.  Note that height here is no

different than thinking about height in opposite hemispheres on Earth – both are up.

24 . Convert this to an estimate of the height of the prominence in kilometers.

(Sun's diameter = 1,390,000 km)

25.  How many Earths could fit under the prominence?

(Earth's diameter = 12,756 km)

• Select Slice and draw two slice lines, one across the prominence to show its width and

one out from the Sun to show it height.  Be sure your slice lines include parts of the

image beyond the prominence.

26 . Make a sketch of your two graphs on the answer sheet.

Seeing is believing, so they say.  But sometimes what you see is not enough.  You have

two ways to see the prominence, in the image itself and on the Slice graph.

• Drag in one of the graph windows so the distance and brightness coordinates are shown

and a small box appears on the slice line in the image.  Drag the cursor to the place on the

graph corresponding to the left or outside edge of the prominence.  In the image window

does the box showing where you are along the slice also appear to be at the edge of the

prominence?  Often it does not.

27.   Increase the value for Max until the prominence almost whites out.  Make another

Slice on top of one of slices you made for #26 .

A.   Compare these two Slice graphs.  What is different?  What is the same?

B.   What is the distance in pixels between the apparent edge of the prominence in the

image and the edge shown on the graph?
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 Date: ________________  Name: ________________________

Answer Sheet: Activity I: Displaying An Image
Introduction to Image Processing

1.   Labels of the icons.

2.   Labels of the 4 bars.

3 . What happens to detail in the bottom left part of the image:

4 . What happens to detail in the top part of the image:

5 . What happens to detail in the bottom left part of the image:

6 . What happens to the detail in the top part of the image:

7 . How Log scaling alters the image - what is better,  what not:
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Date: ______________ Name: ________________________

Answer Sheet: Activity II: About the Display
Introduction to Image Processing

8 .  The (x,y) coordinates of the bottom left corner of the window in Moon:

9 .  The (x,y) coordinates of the top right corner of the window in Moon:

10 . The window dimensions:

11 . The (x,y) coordinates, bottom left corner of the window:

12 .  The Window dimensions:

14 . What Zoom does to the display window dimensions and to the (x,y) coordinates of

any specific feature in the image:

15.  The dimensions of the image window, only part of which is displayed at any one time,

compared to the image window dimensions at Zoom 2.

16 . Pixel and brightness values.

17 . An estimate of the range of values for the lightest shade of pink in Moon;1:

______     to     ______     Counts

18 . What happens to the range of each color when I use log scaling:
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Date: ______________  Name: ________________________

Answer Sheet: Activity III:  Tools for Analyzing Images
Introduction to Image Processing

19 . My slice on the image and the graph with labels of the bright and dim points on both.

20.  Why the cusps (high points) in the graph are all different heights:

21 . Distance, in pixels, from the central peak to the large crater rim:
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Date: ______________  Name: ________________________

Answer Sheet: Activity IV:  Explore a Solar Eclipse
Introduction to Image Processing

22 . Settings:

Color palette:     ____________    

Min/Max: _____      _____ Log (y/n)  __

23 . Height of the solar prominence and the diameter of the sun in pixels

    Prominence: ______

Sun: ______

24 . Height of the solar prominence in sun diameters:

(Sun's diameter = 1,390,000 km) ______

25 . How many Earths could fit under the prominence:

(Earth's dia = 12,756 km) ______

26 . Sketch of my two Slice graphs.

27  A.   Different in my two slice graphs:

The same in my two slice graphs:

27 B.   Difference between the edge of the prominence in the image and in the slice graph:
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HANDS-ON UNIVERSE™
SUPPLEMENTARY ACTIVITY 1

CCD IMAGES - A Color Coding Activity

The images from the HOU telescopes are generated using a CCD camera.  This kind of

camera uses an electronic chip rather than the photosensitive chemical films used by regular

cameras.  The electronic chip is divided into many small areas that collect and record light.

Each pixel on the screen is then given a number based on the amount of light from that

particular area of the CCD chip.  The more light at a pixel, the larger the number.  The

computer assigns a shade of gray or a color (when using a false color palette) at each pixel

to produce the image you view on the screen.

Attached is a grid that simulates a CCD image with each pixel assigned a number between 0

and 9 to represent the amount of light at that pixel.  Using only four different colored

markers, develop a color coding scale for the ten different brightness values, 0 to 9.

Indicate your color code in the Key at the bottom of the screen.  Using your color scale,

color each pixel with its proper color.

Tape your sheet on the wall with everyone else's and compare the result of using different

color scales to represent the same data.

1 .  What is different and what is the same as you look at the collection of grids?

2 .  How does this activity relate to Min/Max settings in the image processing program?

3 .  Did anyone simulate a log scale in his or her color coding scale?  If so, what difference

did it make?  If not, what difference do you believe it would have made?

4 .  Each coding scale can be thought of as a different color palette.  Compare the grid

images in terms of the pros and cons of using different palettes.
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Date: ________________ Name: ________________________

Answer Sheet: Supplementary Activity 1: CCD Images
A Color Coding Activity

Color Key                                     

Brightness Key:                                           
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Activity V:  Download an Image

The images used in the HOU curriculum units plus many more are stored in the Lawrence

Berkeley Lab computer.  They are available by going to the HOU Home Page on World

Wide Web (WWW).  You can get there by using a web browser for accessing the HOU

website -- http://hou.lbl.gov. Click on the “Images” link and follow instructions there.  As

you might expect, websites are subject to revisions and improvements at any time, so we

cannot give you step by step download instructions here.  Find them on the HOU Images

web page.

Give some thought to your own computer’s file folder hierarchy.

It is usually best to download the new image(s) into an HOU Images folder.  This folder

should be inside your HOU folder.  If helpful, you can set up individual folders within

your image folder.




